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ЗАГАЛЬНІ ВІДОМОСТІ 

Навчальна дисципліна «Технології опрацювання інформації» 

відноситься до циклу дисциплін професійної та практичної підготовки 

бакалаврів за програмою ступеневої вищої освіти професійного 

спрямування 186 «Видавництво та поліграфія». Кредитний модуль 

«Технології опрацювання інформації 2. Обробка графічної інформації» 

включає лекційні заняття, комп’ютерний практикум, індивідуальні та 

самостійні заняття. 

Програма кредитного модуля розрахована на вивчення теоретичних 

основ опрацювання графічної інформації на додрукарській стадії 

поліграфічного виробництва; вивчення сучасних програмних засобів 

обробки графічної інформації. 

Знання, отримані студентами в процесі вивчення кредитного модуля 

«Технології опрацювання інформації 2. Обробка графічної інформації», 

успішно можуть використовуватися при вивченні інших спеціальних 

дисциплін, під час курсового і дипломного проектування, а також  

у подальшій виробничій діяльності на поліграфічному виробництві. 

Метою кредитного модуля «Технології опрацювання інформації 2. 

Обробка графічної інформації» є вивчення теоретичних основ 

опрацювання та підготовки графічної інформації для відтворення оригінал-

макетів; здобуття практичних навичок роботи у спеціальних комп’ютерних 

програмах. 

В результаті вивчення даного курсу студенти повинні знати: 

 стандарти та технічні вимоги до образотворчих оригіналів; 

 способи та технології процесів опрацювання образотворчої 

інформації; 

 апаратне забезпечення опрацювання образотворчих оригіналів; 

 види комп’ютерної графіки та форматів файлів; 
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 спеціальні програми обробки образотворчої інформації. 

Студенти повинні вміти: 

 аналізувати та оцінювати придатність образотворчих оригіналів до 

відтворення; 

 працювати з пристроями введення інформації; 

 проектувати технологічний процес відтворення різних 

образотворчих оригіналів; 

 працювати з програмами растрової та векторної графіки;  

 створювати оригінал-макети за допомогою спеціалізованих 

комп’ютерних програм; 

 виконувати виведення зображення на паперовий носій. 

 

2. МЕТА ПРАКТИЧНИХ РОБІТ 

Проведення практичних робіт ставить за мету закріплення та поглиб-

лення теоретичних знань, набуття практичних навичок додрукарської 

обробки оригіналів образотворчої інформації. Характер практичних робіт, 

їх зміст та методика проведення передбачають пізнання, осмислення та 

практичне засвоєння студентами прийомів і способів введення та обробки 

різних видів образотворчих оригіналів.  

 

3. ВИМОГИ ДО ВИКОНАННЯ ТА ЗАХИСТУ  

ПРАКТИЧНИХ РОБІТ  

Роботи виконується під безпосереднім керівництвом і контролем 

викладача у комп’ютерному класі кафедри технології поліграфічного 

виробництва, і, при необхідності, вдома. Перед виконанням кожної 

практичної роботи, студент повинен ознайомитися зі змістом конкретного 

завдання, запропонованою методикою виконання, опрацювати теоретичний 
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матеріал. Виконуючи практичну роботу, студент повинен дотримуватися 

порядку і методики її здійснення. 

Практичні роботи захищаються по мірі виконання. Захист відбувається 

при наявності цифрового файлу та відповідей на поставлені викладачем 

запитання. Студент допускається до складання іспиту з дисципліни за умови 

позитивного захисту всіх практичних робіт та при наявності звіту з практич-

них робіт, який включає роздруковані роботи на формат А4 та пояснення з 

використання основних команд і послідовності виконання завдання. 

 

4. КРИТЕРІЇ ОЦІНЮВАННЯ ВИКОНАННЯ РОБІТ 

Оцінка за виконання практичних робіт враховує відповідність 

виконаної роботи сутності завдання, обсяг і рівень використаних теоре-

тичних і практичних знань, наявність елементів творчого, продуктивного 

мислення, оригінальність способу вирішення завдання. 

Критерії оцінювання виконання та захисту практичних робіт: 

– повне виконання практичної роботи і вичерпні відповіді 

при усному захисті 
– 5 

– повністю виконана робота, але відповіді при захисті 

лаконічні, стислі 
– 4 

– неповністю виконана робота і незадовільний захист – 1…3 

– робота виконана, але здана не у визначені терміни – 0 

При повному виконанні всіх робіт у визначені терміни студент може 

отримати заохочувальні бали (до 10 балів) додатково до свого рейтингу за 

результатами виконання творчих робіт з дисципліни: оригінальна 

підготовка та звіт практичних робіт, рефератів, які сприяють підвищенню 

технічної ерудиції.  

За використання чужих робіт і завдань, як своїх (плагіат), відсутність 

без поважних причин на трьох і більше заняттях, несвоєчасне виконання 

завдань, студенту можуть бути нараховані штрафні бали (до 10 балів). 
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ПРАКТИЧНА   РОБОТА   1 

ВИВЧЕННЯ СПОСОБІВ ВИДІЛЕННЯ, МАСШТАБУВАННЯ, 

ОБРІЗКИ ТА РЕТУШУВАННЯ ЗОБРАЖЕНЬ 

Мета роботи: ознайомлення з інтерфейсом програми Adobe 

Photoshop, панелями інструментів, налаштуванням робочого середовища, 

вивчення інструментів виділення об’єктів, основних способів ретушуван-

ня, масштабування зображень. 

Завдання роботи: провести обрізку, ретушування, колірну корекцію, 

заміну фону зображень. 

Теоретичні відомості: Всі палітри інструментів розміщені в меню 

Window, підключаються за необхідності. Загальні налаштування програми: 

Edit Preferences.  

Управління переглядом. Навігація, зміна масштабу перегляду 

зображення здійснюється через палітру Navigator, меню View, інструменти 

Zoom Tool або Hand Tool (або натисненні клавіші «Пробіл»). Під час роботи 

над зображенням зручно користуватися комбінаціями Ctrl– (зменшує), Ctrl+ 

(збільшує), Ctrl-0 (максимальний розмір зображення на екрані), Ctrl+1 

(реальний розмір зображення). 

Інструменти виділення. Для 

виділення об’єктів заданої форми 

застосовуються інструменти Rec-

tangular та Elliptical Marquee, Lasso, 

Polygonal та Magnetic Lasso. Виділення пікселів зображення залежно від їх 

кольору виконується за допомогою інструментів Quick Selection та Magic 

Wand. Для внесення змін у виділення застосовуються панель опцій 

інструменту Selection та команди Modify меню Select: Border (Рамка), 

Smooth (Згладжування), Expand (Розширення), Contract (Стиснення), 

Feather (Розтушування); для збереження виділення — команда Select Save 

Selection, створюється додатковий канал, який розміщується в палітрі 
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Channels; для інвертування виділення — Select Inverse; для зняття виділення 

— Select Deselect (або Ctrl+D); для виділення ідентичних пікселів по 

всьому зображенню — Select Similar; трансформування зони виділення — 

Select Transform Selection; для уточнення та корекції виділення зображення 

— Selection  Refine Edges. 

Колір. Параметри кольору встановлюються за 

допомогою палітр Color/Color Picker. Для зафарбо-

вування виділених ділянок зображення застосовується 

інструмент Paint Bucket Tool або Alt+Backup (для 

зафарбовування кольором переднього плану), Ctrl+ 

Backup (для фонового кольору).  

Шари. Складові елементи оригінал-макету доречно 

розміщувати на окремому шарі в необхідному порядку.  

На палітрі Layer розміщені опції: Link Layer (Зв’язати 

шари), Add a layer style (Додати стиль шару), Add layer 

mask (Додати маску шару), Create new fill or adjustment 

layer (Створити новий шар заливання або корегування), 

Create a new group (Створити групу шарів), Create a new 

layer (Створити новий шар), Delete layer (Видалити 

шар). Також на палітрі розміщені опції Set the blending mode for the layer 

(Накладання), Opacity (Прозорості), Locked (Блокування). 

Обрізка/кадрування. Для кадрування/обрізки зображення призначений 

інструмент Crop (Обрізка), який дає можливість як вільного вибору 

розміру зображення, так і введення чисельних значень на панелі опцій 

інструмента. Функція Perspective інструмента Crop дозволяє вирівнювати 

нахилені об’єкти, шляхом розташування рамки обрізки паралельно нахилу 

об’єкту. 

Масштаб з врахуванням вмісту. Дана функція дозволяє швидко 

змінити орієнтацію зображення, наприклад з альбомної на портретну без 
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деформації ключових об’єктів. Для цього необхідно виділити зображення 

(Ctrl+A) далі Edit Content-aware Scaling (Масштаб с врахуванням вмісту), 

деформувати за краї зображення до центру. Програма сама 

прораховує які ділянки необхідно відкинути. Для захисту 

ключового об’єкту, необхідно попередньо створити 

додатковий канал (альфа-канал) з виділення (Select Save Selection) і потім 

обрати цей канал на панелі налаштувань.  

Розміри зображення. Визначення розмірів зображення Image Image 

Size. Для збереження загальної кількості пікселів зображення необхідно 

відключити Resample Image меню Image Image Size. Для збереження 

розмірів зображення (ширини/висоти) включити Resample Image. Зміна 

розмірів робочої зони Image Canvas Size. Поворот та віддзеркалення 

зображення Image  Image Rotation/Flip Canvas Horizontal (Vertical). 

Інструменти ретушування. Інструменти Spot Healing Brush Tool/Healing 

Brush Tool/Patch Tool/Red Eye Tool застосовуються для проведення місцевого 

ретушування. Інструмент Clone Stamp Tool дозволяє дублювати або 

відновлювати ділянки зображення, працює при натисненні клавіші Alt.  

Для заміни/видалення об’єктів з фону зручно користуватися заливкою 

з врахуванням вмісту Fill Content-Aware, попередньо необхідно виділити 

об’єкти будь-яким зручним способом. 

Для висвітлення/затемнення зображень застосовується команда 

Image Adjustments Brightness/Contrast (Яскравість/Контраст) або Shadow/ 

Highlight (Тіні/ Світа), а також інструменти місцевої дії Dodge/Burn Tool. 

Налаштування рівнів яскравості зображення: Image  Adjustments Levels 

(Рівні). 

Зміна колірного відтінку та насиченості зображення: Image  

Adjustments Color Balance (Баланс кольору), Hue/Saturations (Колірний 

тон/Насиченість), Channel Mixer (Змішування каналів) та інші. 
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Інструменти видалення. Для часткового видалення частин 

зображення призначені інструменти Eraser, Magic Eraser, Background Eraser 

(табл. 1). Для видалення темного контуру навколо вирізаних частин 

зображення застосовуються команди меню Layer Matting: Defringe (на 

кольоровому тлі)/Remove Black Matte/Remove White Matte (на чорному/ 

білому тлі). 

Таблиця 1 — Налаштування параметрів інструмента Eraser 

Інструмент: 

налаштування 
Принцип дії/характеристика 

Background Erase tool: 

Sampling (метод дії) 

 

 

 

 

 

Limits 

 

 

 

 

 

Protect Foreground Color 

 

1. Continuous (неперервно): видаляються пікселі, залежно від зміни кольору 

    фону, під час протягування по ним курсору; 

2. Once: видаляються пікселі, колір яких визначається одноразово при першому 

    кліку на зображенні;  

3. Background Swatch: колір пікселів, що видаляються, задається на панелі 

    інструментів як Background Color. 

1. Discontiguous (несуміжні): видаляються всі пікселі, які ідентичні за 

кольором пікселам, що попали у зону дії інструмента; 

2. Contiguous (суміжні): видаляються лише суміжні пікселі проби (першого 

кліку мишкою), що попадають у поле дії інструменту; 

3. Find Edges: зона дії інструменту визначаєтьмя контрастними границями на 

зображеннях. 

Блокування кольору переднього плану 

Magic Eraser tool: 

Tolerance 

Anti-alias 

Contiguous 

Sample All Layers 

 

Ступінь ідентичності (близькості) кольору пікселів 

Згладжування різких границь 

Видаляються близькі по кольору пікселі на суміжних ділянках 

Дозволяється видалення на всіх шарах 

 

Під час роботи над зображенням, всі здійснені операції відображаються 

на палітрі Window History, максимальна кількість операцій налаштовується 

Edit Preferences Performance History States. Відміна операцій відбуваєть-

ся, шляхом кліку на відповідній операції палітри History. Для дублювання 

стану зображення є два варіанта: перший, створення знімку (палітра 

History Create new Snapshot) — створює копію стану зображення, розміщує 

в палітрі History; другий, створення нового документу з поточного стану 

зображення (палітра History Create new document from current state). Палітра 

History та інструмент History Brush Tool дозволяють повертати окремі 

частини зображення до початкового (необхідного) стану. Для цього 
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необхідно в палітрі History відзначити позицію повернення (клік на палітрі 

History ліворуч від позиції) та обрати інструмент History Brush Tool, 

необхідного розміру, і провести ним там, де потрібно повернутись до 

відзначеного етапу редагування.  

Основним форматом збереження зображень у програмі Adobe 

Photoshop є psd. Формати psd, tiff, pdf — формати в яких зберігаються такі 

додаткові налаштування зображення, як багатошаровість, прозорість шару, 

коректувальні шари, текстові шари, ефекти шару, сітка та направляючі, 

ICC профілі системи управління кольором (в pict, jpeg, dcs, eps профілі 

також зберігаються). Формат psd зберігає файли розміром до 30 тис. 

пікселів/2 Гб; формат tiff підтримує файли розміром до 4 Гб. Для 

збереження файлів більших розмірів застосовується формат psb.  

Методика виконання роботи: 

1. Створити новий документ з властивостями: формат – А4, 

розташування – вертикальне, роздільна здатність – 72 dpi, колірний простір 

– RGB.  

2. Відповідно до варіанту, провести обробку зображень (табл. 2): 

 провести кадрування з вирівнюванням основних об’єктів (п. 1); 

 змінити орієнтацію зображення з альбомної на портретну (п. 2); 

 видалення частин зображення (п. 3); 

 замінити фон зображення (п. 4); 

 виконати ретушування: позбутися муару, видалити шуми, 

подряпини (п. 5); 

 виконати колірну корекцію зображення (п. 6). 

3. Кожне з оброблених зображень (1–6) перенести у документ, 

створений у пункті 1, тобто створити збірний багатошаровий документ. 

4. Зберегти файл (Прізвище_група_Lab1). 
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Таблиця 2 — Приклад виконання практичної роботи 1 

Зображення до обробки Зображення після обробки 

1 

  

2 

  

3 
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Закінчення табл. 2 

Зображення до обробки Зображення після обробки 

3 

  

4 

  

5 
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Контрольні запитання усного звіту: 

1. Загальні налаштування програми Photoshop? 

2. Які дії необхідно виконати для збереження файлу? 

3. Які типи файлів допустимі для відкриття/збереження? 

4. Як підключити панель інструментів? 

5. Як підключити/закрити необхідні палітри? 

6. Як наблизити/віддалити об’єкти на екрані? 

7. Як побачити об’єкти на екрані у певному масштабі? 

8. Як показати/сховати лінійки? 

9. Як показати/сховати/заблокувати направляючі? 

10. Як встановити (змінити) нуль координат? 

11. Як виділити/видалити будь-який об’єкт? 

12. Налаштування перегляду каналів на палітрі Channels у чорно-

білому/кольоровому режимах? 

13. Налаштуйте колірне охоплення робочої зони? 

14. Налаштуйте палітру History? 

15. Налаштуйте одиниці вимірювання: геометричні, тексту, роздільної 

здатності? 

16. Інструменти групи виділення: їх налаштування, збереження 

виділення, розширення/зменшення, створення рамки з виділення? 

17. Реалізуйте розтушування країв зображення під час виділення? 

18. Уточнення та корекція контуру виділення? 

19. Інструменти часткового виділення частин зображення? 

20. Визначення/зміна розміру зображення/підкладу? 

21. Як зменшити зображення при збереженні загальної кількості 

пікселів у зображенні? 

22. Як встановити значення кольору в Lab, RGB, CMYK для 

переднього та заднього фону? 

23. Як виконати переміщення шарів між собою?  
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ПРАКТИЧНА   РОБОТА   2 

СКАНУВАННЯ ОРИГІНАЛІВ. ФУНКЦІЯ «ACTION» 

І ПАКЕТНА ОБРОБКА ЗОБРАЖЕНЬ 

Мета роботи: вивчення основних налаштувань при скануванні 

зображення; засвоєння принципів роботи основних інструментів та команд 

при обробці зображення; навчитися записувати «екшени» для обробки 

значної кількості зображень. 

Завдання роботи: здійснити сканування оригіналів: фотографії, полі-

графічні відбитки (напівтонові, штрихові), слайди. Провести ретушування 

та колірну корекцію зображень. Провести пакетну обробку зображень. 

Теоретичні відомості: 

Сканування зображення можна здійснити у програмі Adobe Photoshop 

File Import WIA Support або у програмному забезпеченні пристрою 

сканування, в якому доступно значно більше налаштувань для вибору 

оптимальних параметрів сканування, таких як: режим сканування (слайди, 

поліграфічні відбитки, фотокартки), колірна модель (RGB, Grayscale, Lab, 

CMYK), роздільна здатність, зміна розміру, видалення пилу, подряпин та 

муару, підвищення різкості, налаштування кольору та інше.  

Для характеристики розподілу пікселів зображення за яскравістю 

застосовується гістограма розподілу значень тонів: (Image Adjustments  

Levels). Розподіл тонів на гістограмі відображається від чорного до білого 

(зліва направо) вздовж вісі Х, на вісі У відображається кількість інформації 

зображення у межах діапазону сірого. Чим вищий пік, тим більше інфор-

мації зображення попадає в цей діапазон сірого. 

Якщо гістограма зміщена вліво — зображення має багато тіней та 

чорного кольору. Гістограма зміщена вправо — багато освітлених ділянок 

та білого на зображенні. Збалансовані та симетричні гістограми 

відповідають збалансованим тонам на зображенні (див. рис. 1). Відсутність 

на зображені найтемніших та найсвітліших ділянок відповідає блідому 

зображенню.  
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У вікні Levels розміщені наступні основні параметри: Channel (Канал), 

Input Levels (Вхідні значення), Output Levels (Вихідні значення), Gamma 

(Гама), Auto, кнопки з «піпетками». Input Levels використовуються для 

зміни контрастності зображення за рахунок затемнення найтемніших 

кольорів і висвітлення найсвітліших. Gamma — середнє поле параметра 

Input Levels, тобто рівень яскравості середньо-сірого кольору на 

зображенні. Значення «гама» може змінюватися від 0,1 до 9,99, при цьому 

1,0 відповідає «найбільш середнім» сірим кольорам, а його зміна 

призводить до зниження контрастності за рахунок освітлення або 

затемнення сірих кольорів без зміни світлин та тіней.  

 

   

   

Рис. 1. Гістограми зображень з різним розподілом тонів: 

гістограма зверху 

відповідає зображенню  

з великою кількістю тіней 

гістограма демонструє 

зображення з рівномірним 

розподіленням інформації 

по всім відтінкам  

гістограма зверху 

відповідає зображенню  

з великою кількістю 

світлин 
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Output Levels застосовуються для зменшення діапазону рівнів яскра-

вості зображення за рахунок висвітлення найтемніших пікселів і затемнен-

ня найсвітліших. За допомогою бігунків Output Levels можна інвертувати 

зображення, якщо поміняти їх місцями.  

Параметр Auto дозволяє автоматично перетворити найтемніші пікселі 

виділеної ділянки зображення на чорні, а найсвітліші на білі. Затемнення/ 

висвітлення виконується в межах, що встановлені у вкладці Options вікна 

Levels (по замовчуванню Shadows/Highlights Clip 0,1 %), щоб збільшити 

кількість пікселів, перетворюваних на білі/чорні, необхідно ввести вищі 

значення і навпаки. 

Кнопки з «піпетками» автоматично налаштовують колір. Якщо 

клікнути на пікселі  при активній «піпетці» чорного кольору, то програма 

перетворить колір цього пікселя й усі темніші кольори на чорний; біла — 

колір вибраного пікселя й усі світліші на білий. «Піпетка» сірого кольору 

застосовується для зміни, вибраного кольору на середньосірий. 

Видалення шуму та подряпин, по всій площі зображення або на 

виділеній ділянці, забезпечується фільтрами Noise Dust& Scratches/Reduce 

Noise Filter, видалення муару — фільтрами Noise Median, Blur Blur/Blur 

Gaussian/Smart Blur. Для підвищення різкості зображення застосовують 

фільтри групи Sharpen або фільтр з групи Other High Pass при режимі 

накладання шарів Overlay або Soft Light. 

Інструменти ретушування місцевої дії Blur Tool (Розмиття), Sharpen 

Tool (Різкість), Dodge Tool (Освітлення), Burn Tool (Затемнення), Sponge 

Tool (Зміна насиченості). 

Корекцію зображення можна виконати у два способи: перший, 

застосування корекції безпосередньо до виділеної ділянки шару або взагалі 

до шару; другий, використання корегувальних шарів, які діють на всі видимі 

шари, розміщені під ним (а не лише на поточний). Особливість 

корегувальних шарів в тому, що вони не змінюють пікселі до тих пір, поки 

на будуть об’єднані (злиті) з шаром до якого застосовувались. Для 

застосування корегувального шару необхідно виділити шар на палітрі 
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Layers і клікнути Create new fill or adjustment layer знизу палітри. Щоб 

об’єднати корегувальний шар з шаром до якого він застосовувався на 

палітрі Layers Merge Down.   

Швидкі методи корекції яскравості. Для коригування яскравості 

зображень необхідно продублювати шар, на якому знаходиться зображення, 

і надати йому режим накладання відмінний від Normal: Screen — для 

темних; Overlay — для нормальних; Multiply — для світлих зображень. 

Функція Action. Для однотипної обробки значної кількості зображень 

(наприклад, приведення до одного розміру, видалення муару, оформлення 

рамкою тощо) зручно користуватися «екшенами» — чіткий порядок дій, 

що виконується над зображенням в автоматичному режимі. Для створення  

«екшену» необхідно підключити палітру Window Action, яка містить 

наступні пункти: 

1.Button Mode — режим візуального сприйняття поточних операцій у вигляді 

кнопок. 

2.New Action — створення нового «екшену». 

3.New Set — створення нового набору операцій. 

4. Duplicate — створення копії набору або окремої операції. 

5. Delete — видалення набору або окремої операції. 

6. Play — відтворення «екшену». 

7. Start Recording — запис операції спочатку. 

8. Record Again — запис операції далі. 

9. Insert Menu Item — додавання пункту меню в операцію. 

10. Insert Stop — додавання зупинки в «екшен». 

11. Insert Path — додавання контуру в операцію (наприклад з Illustratr-а). 

12. Action Option — дозволяє призначити гарячі клавіші операції, назву та колір. 

13. Playback Options — налаштування відтворенняя операції, такі як Accelerated, 

Step by Step, Pause for. 

14. Clear All Actions — видалення всіх наборів або операцій. 

15. Reset Actions — заміна всіх наборів або операцій, встановленими по-

замовчуванню. 

16. Load Actions — завантаження «екшенів». 
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Для створення нової операції необхідно відкрити на палітрі Action  

New Action вказати назву операції, а потім натиснути Begin Recording на 

палітрі Action. Кожна дія буде записана послідовно, для закінчення запису 

натиснути Stop на палітрі Action.  

Для застосування створеної операції до набору 

зображень, необхідно перейти в режим автомати-

зації обробки зображень File  Automate Batch. 

У полі Action вибрати необхідну операцію; в полях 

Source/Destination вибрати папку з вхідними 

зображеннями та папку для збереження зображень 

після обробки.  

Методика виконання роботи: 

1. Провести сканування зображень (відповідно до варіанту), 

визначити їх гістограми: 

– кольорова фотокартка (підібрати самостійно); 

– чорно-біла фотокартка (підібрати самостійно); 

– слайд (підібрати самостійно); 

– поліграфічні відбитки (видає викладач).  

2. Зберегти скановане зображення та його гістограму, 

(Прізвище_група_Lab2_1). 

3. Виконати обробку сканованого зображення:  

 здійснити обрізку зображення, щоб видалити зайві зони; 

 провести відновлення відсутніх частин зображення; 

 вирівняти фон зображення; 

 позбутися муару, видалити шуми; 

 відкорегувати яскравість та контрастність зображення; 

 відкорегувати колірний зміст зображення. 

4. Визначити гістограми зображень після обробки, зберегти файл 

(Прізвище_група_Lab2_2) (див. табл. 3). 
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Таблиця 3 — Приклад виконання практичної роботи 2 

Скановане зображення Гістограма до обробки зображення 

 

 

Оброблене зображення Гістограма після обробки зображення 

 

 

 

5. Провести пакетну обробку зображень на прикладі зміни розміру та 

створення рамки зображення: 
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– для обробки обрати папку Laboratorni_Photoshop/Lab_1/ 

Видалення (містить 20 зображень); 

– зменшити розмір зображень до 500 пікселей по ширині; 

– додати рамку на зображенні, яка має наступні характеристики: 

  

 

Приклад виконання завдання: створення рамки 

 
 

 

Контрольні запитання усного звіту: 

1. Налаштування параметрів (опцій) сканування? 

2. Колірні моделі сканування? 

3. Характеристика діаграм розподілу значень тонів (Levels)? 

4. Характеристика вхідних рівнів (Input Levels) палітри  Level? 

5. Output Levels вихідних рівнів (Output Levels) палітри  Levels? 

6. Параметр Auto палітри  Levels? 

7. Видалення шуму/подряпин/муару на частині та по всій площі 

зображення? 

8. Підвищення різкості на окремій частині та по всій площі 

зображення? 

9. Інструменти ретушування місцевої дії? 

товщина 2 пікселя, колір чорний; 

товщина 30 пікселів, колір сірий; 

товщина 2 пікселя, колір чорний 
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10. Корегувальні шари: спосіб їх створення, переваги застосування? 

11. Палітра Layer та її опції? 

12. Як здійснити кадрування зображення та обрізку з заданим 

розміром 100×110 мм? 

13. Як створити дублікат документу та змінити його показники? 

14. Як зафарбувати об’єкт, створеним кольором з заданими 

показниками? 

15. Як здійснити клонування частини зображення? 

16. Реалізація пакетної обробки зображень? 

17. Запис та внесення змін до «екшену»? 

 

 

ПРАКТИЧНА   РОБОТА   3 

ТРАНСФОРМАЦІЯ ОБ’ЄКТІВ ТА ІМІТАЦІЯ ОБ’ЄМУ 

Мета роботи: навчитися створювати та застосовувати градієнти, 

виконувати трансформацію, масштабування та вирівнювання об’єктів, 

користуватися ефектами шару. 

Завдання роботи: створити об’єкти, такі як плівка, об’ємні предмети, 

сувій; виконати трансформування/вирівнювання об’єктів; створити градієнти 

та відблиски на зображенні. 

Теоретичні відомості: 

Для вирівнювання об’єктів слід виділити шари на яких вони 

знаходяться, при натисненні клавіші Shift, і на панелі налаштувань 

натиснути відповідну позицію: 

Для створення негативного зображення необхідно виконати команду 

Image Adjustments Invert.  

Blending Options (Ефекти шару). Для створення ефектів опуклості, 

тіней, обведення по контуру та інших на палітрі Layer слід обрати Add a 

layer style Blending Options і встановити необхідні показники на палітрі 

. 
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Layer Style. Для створення відблиску 

застосувати Filter Render Lighting effects, 

блік на предметі можна додати через 

Filter Render Lenc Flare або вибрати 

пензлик, відповідного кольору із прозорістю 

меншою 100 %. Також для корекції об’єму 

фігур можна застосувати Filter Distort  

Spherise/Diffuse Glow. Різноманітні види 

текстур можна надати зображенню через Filter Texture або на палітрі 

Layer Style Pattern Overlay.  

Градієнт. Для роботи з градієнтом призначені 

інструмент Gradient Tool, панель налаштувань 

градієнту та палітра редактора градієнта 

(Gradient Editor), яка дозволяє створювати 

градієнти різних кольорів, інтенсивності, 

типів. Поле Gradient Type дозволяє створити 

гладкий градієнт (Solid) або градієнт з дода-

ванням шуму (Noise). Для поєднання/злиття 

двох градієнтів необхідно застосувати режим 

накладання Lighten на панелі Layers.  

Для створення характерних бліків та тіней на сувої зручно 

користуватися пензлями, налаштовуючи колір, прозорість та тип пензлю, 

виконувати фарбування при натисненні Shift і двох кліків ЛКМ (початок та 

кінець). 

Накладання текстури виконується через Filter Distort Displace: для 

цього необхідно обрати текстуру, зберегти її у форматі psd, і потім обрати 

створений файл у налаштуваннях фільтру. 

Трансформування та створення масиву. Для здійснення 

трансформування призначені команди Edit Free Transform (Ctrl+T)/ 

Transform (Scale/Rotate/Skrew/Distort/Perspective/Warp/ Rotate 180 ,90 CW, 

90 CCW/Flip Horizontal/Vertical. Для створення масиву об’єктів 
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застосовуються різні налаштування трансформації (масштабування/ 

повороту/зміщення), які вказуються на палітрі трансформування:  

 

Комбінації клавіш:Ctrl+Alt+T — створює дублікат об’єкту (шару) із 

застосуванням трансформації; Ctrl+Shift+Alt+T — повторює, попередньо 

застосовану трансформацію, створюючи кожного разу новий шар. Для 

отримання суцільного об’єкту необхідно об’єднати всі шари, з яких він 

складається, для цього на панелі Layers виділити потрібні шари при 

натисненні клавіші Shift, а потім натиснути комбінацію Ctrl+E. 

Для створення цікавих ефектів (закручування тощо) під час створення 

масиву треба змінити/змістити центр трансформування, шляхом перетягу-

вання мишкою. 

Методика виконання роботи: 

1. Створити новий документ з властивостями: формат – А4, 

розташування – вертикальне, роздільна здатність – 300 dpi, колірний 

простір – RGB. 

2. Створити об’ємні предмети за зразком (табл. 4, п. 2–4). 

3. Виконати трансформацію об’єктів, застосувавши кут повороту, 

вертикальне/горизонтальне масштабування, скос (табл. 4, п. 5–8). 

4. Створити сувій за зразком (табл. 4, п. 9). 

5. Створити каркас плівки та розмістити в ньому створені 

зображення у п. 5–9. 

6. Перевести позитивні зображення у негативні (табл. 4, п. 1). 

7. Створити об’ємну модель молекули, застосувати накладання 

текстури та тінь ((табл. 4, п. 10). 

8. Зберегти файл (Прізвище_група_Lab3). 
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Таблиця 4 — Приклад виконання практичної роботи 3 

 

1 

 

2 

 

3 

 

4 

 

5 
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Закінчення табл. 4 

 

6 

 

7 

 

8 
 

9 

 

10 
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Контрольні запитання усного звіту: 

1. Види/призначення меню Filter? 

2. Як створити об’ємні предмети та відблиски на них? 

3. Як створити тінь від об’єкту та змінити її колір? 

4. Як створити/змінити опуклість об’єкту? 

5. Як створити/редагувати/зафарбувати векторний контур? 

6. Як створити лінійний, відцентрований; циліндричний, пірамідаль-

ний, конусоподібний багатокольоровий градієнт? 

7. Як змінити колір у створеному градієнті? 

8. Як згрупувати/розгрупувати (об’єднати)/заблокувати об’єкти? 

9. Як створити/включити/відключити шари? 

10. Чим характеризується кожен шар? 

11. Як об’єднати/видалити/дублювати шари? 

12. Як віддзеркалити/дублювати/трансформувати будь-який об’єкт? 

13. Як визначити розмір об’єкта? 

14. Як змінити порядок накладання об’єктів? 

15. Як вирівнюються об’єкти між собою? 

16. Як вирівняти об’єкт по центру сторінки?  

17. Як накласти текстуру на об’єкти; змінити колір та насиченість 

текстури? 

 

ПРАКТИЧНА   РОБОТА   4 

ОФОРМЛЕННЯ ЗОБРАЖЕННЯ ВІЗЕРУНКАМИ 

Мета роботи: вивчення інструмента Pen, засвоєння принципів 

зафарбовування ділянок зображення візерунками, градієнтами, пензлями; 

використання фільтрів.  

Завдання роботи: створити ескіз зображення інструментом Pen; 

скориставшись інструментом Brush Tool або фільтром Pattern Maker, 

створити базу візерунків та зафарбувати ескіз, створити зображення-пазл, 

застосувати фільтри до створеного зображення, відповідно до варіанту . 
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Теоретичні відомості: 

Інструмент Pen. Створення складних контурів виконується 

аналогічно програмі Adobe Illustrator, за допомогою інструмента Pen 

Tool/Freeform Pen або Custom Shape Tool. При роботі, вказаними 

інструментами, доступні три режими рисування: перший, Shape Layer 

(шар-фігура, створюється на новому шарі і складається з шару заливки, що 

визначає колір фігури, і пов’язаної з ним векторної маски, яка задає межі 

фігури, тобто контур, який з’являється на панелі Paths (Контури). А також 

задаються параметри контуру обведення: колір, тип, товщина, розташу-

вання. Другий, Paths (контур, дозволяє малювати в поточному шарі 

робочий контур, який можна використовувати для вибору фрагмента 

зображення, створення векторної маски, виділення або застосовувати до 

нього заливку/обведення (клік ПКМ Create Vector Mask/Make Selection/Fill 

Path/Stroke Path). Робочий контур вважається тимчасовим, поки не буде 

збережено (палітра Path Save Path). Третій, Fill pixels (заливка пікселями, 

створюються растрові фігури-зображення безпосередньо в шарі. У цьому 

режимі працюють тільки інструменти групи Custom Shape Tool (Фігура). 

Інструментом Brush можна створити основу 

для візерунків. Палітра Brushes містить наступні 

налаштування: прозорість, нахил, щільність/розмір 

пензля, Shape Dynamics (Зміна форми), Scattering 

(Розсіювання), Texture (Накладання текстури), Dual 

Brush (Подвійний пензлик), Color Dynamics (Зміна 

кольору), Noise (Внесення шуму), Wet Edges 

(Отримання «вологих» країв пензля), Airbrush 

(Розпилювання), Smoothing (Згладжування), Protect 

Texture (Захист текстури).  

Розмір пензля, під час рисування, змінюється шляхом натискання 

клавиш «[» або «]». При натисненні Alt курсор переходить в режим піпетки, 

що дозволяє обрати потрібний колір, під час використання інструмента 

Brush.  
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Інструмент Color Replacement Tool (Заміна кольору) призначений для 

заміни кольору елементів зображення на інший (вибраний) колір (табл. 5).  

Інструмент Mixer Brush Tool дозволяє моделювати реалістичні прийо-

ми живопису, такі як змішування кольорів на полотні, поєднання кольорів 

на пензлі, зміну вологості фарби під час нанесення штриха (табл. 5). Також 

застосовується при обробці портретних зображень для усунення 

(згладжування/розмиття) бліків на обличчі, тобто дозволяє усунути різкий 

перехід між градаціями. 

Таблиця 5 — Налаштування інструментів Color Replacement Tool 

та Mixer Brush Tool 

Інструмент: 

налаштування 
Принцип дії/характеристика 

Color Replacement Tool: 

Mode (режими заміни 

кольору) 

 

 

Sampling (метод дії) 

 

 

Limits (установка зони 

дії інструменту) 

 

 

Tolerance 

Anti- alias 

 

Hue заміна лише кольору (тону), насиченість і яскравість не змінюються. 

Satiration заміна лише насиченості, відтінок і яскравість не змінюються. 

Color заміна відтінку та насиченості, яскравість не змінюється. 

Luminosity заміна яскравості, відтінок і насиченість не змінюються. 

1. Continuous (неперервно): вибір кольору безперервно; 

2. Once: вибір кольору одноразово при першому кліку на зображенні;  

3. Background Swatch: заміна пікселів колір, яких співпадає з фоновим.. 

1. Discontiguous (несуміжні): інструмент діє на всі пікселі; 

2. Contiguous (суміжні): інструмент діє на пікселі, які знаходяться в межах дії 

курсору; 

3. Find Edges: схожий з попереднім, але зберігаються границі об’єктів.  

Задається ідентичність пікселів для заміни кольору 

Згладжування пікселів основного зображення та області зафарбовування 

Magic Eraser tool: 

Current Brush load:  

Load Brush 

Clear Brush 

Use solid colors only 

Load the brush after 

each stroke 

Clean the brush after 

each stroke 

Wet 

Load 

Mix 

 

Flow 

Enable airbrush mode 

Sample All Layers 

 

Визначає колір фарбової ємності. 

Вибір кольору пензля, який не має інших колірних домішок. 

Дозволяє очистити ємність від кольору. 

Вибір лише чистого кольору (при натисненні Alt). 

Після кожного мазка на пензлик наноситься вибраний колір з ємності. 

 

Після кожного мазка пензлик очищується, зміщування кольору відбувається 

на зображенні, пензлик залишається чистий. 

Визначає кількість фарби, яку пензлик змішає на зображенні. 

Визначає кількість фарби на пензлі. 

Визначає кількість фарби на пензлі, яка наноситься з ємності. При «0 %» вся 

фарби з зображення, при «100 %» — з фарбової ємності. 

Визначає інтенсивність кольору, який наноситься на зображення. 

Функція активує аерограф (розпилювач). 

Зміщування фарби відбувається на всіх шарах 
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Для внесення оригінального зразка до бази візерунків/пензлів/фігур 

необхідно виділити частину зображення/контур (фігуру) та виконати 

команду Edit Define Pattern/Define Brush/Define Custom Shape. Для 

зафарбовування виділеної зони необхідно виконати команду Edit Fill 

Pattern (створений візерунок, як правило, розміщується в кінці списку). 

Для імітації структури пазлу необхідно накласти ефект шару на палітрі 

Layer: Add a layer style Blending Options→ Styles клікнути ПКМ обрати 

Image Effect→Puzzle, налаштування виконується через ефекти шару Layer 

Style. 

Також для створення візерунків застосовується фільтр Filter→Pattern 

Maker. Для початку необхідно в діалоговому вікні фільтра виділити 

прямокутну ділянку зображення, з якої будуть виділені необхідні пікселі 

для створення візерунка, і натиснути Generate. Після першого застосування 

ефекту кнопка буде називатися «Generate Again», що дозволить створити 

необхідний візерунок, вказавши налаштування в меню фільтра.  

Для імітації певної техніки виконання зображення використовуються 

фільтри меню Filter: Artistic, Stylize, Sketch, Distort, Pixelate та інші. Кожен 

фільтр має свої налаштування, оптимальні, як правило, обираються 

залежно від зображення та необхідного візуального ефекту. 

Методика виконання роботи: 

1. Створити новий документ з властивостями: формат – А4, 

розташування – горизонтальне, роздільна здатність – 150 dpi, колірний 

простір – RGB. 

2. Намалювати ескіз зображення (відповідно до варіанту, табл. 6).  

3. Створити базу візерунків для зафарбовування відповідних зон 

зображення. 

4. Зафарбувати зображення, створеними візерунками (не менше 

чотирьох). 

5. Імітувати на зображенні певну техніку виконання (відповідно до 

варіанту, табл. 7). 

6.  Створити зображення-пазл (табл. 7).  

7. Зберегти файл (Прізвище_група_Lab4). 
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Таблиця 6 — Варіанти завдань для виконання практичної роботи 4 

  

  

  

1 2 

3 4 

5 6 
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Продовження табл. 6 

  

  

  

7 8 

9 10 

11 12 
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Продовження табл. 6 

  

  

  

13 14 

15 16 

17 18 
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Продовження табл. 6 

  

  

  

19 20 

21 22 

23 24 
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Закінчення табл. 6 

  

  

  

 

25 26 

27 28 

29 30 
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Таблиця 7 — Варіанти для виконання п. 5 

№ 

варіанту 
Техніка виконання зображення 

№ 

варіанту 
Техніка виконання зображення 

1 Мозайка 16 Імітація зображення на тканині 

2 Малюнок кольоровими олівцями 17 Малюнок акварельними фарбами 

3 Аплікація 18 Імітація зображення на камені 

4 Фреска 19 Малюнок аерографом 

5 Малюнок олійними фарбами 20 Імітація малюнка на воді 

6 Імітація пластикового паковання 21 Штриховий малюнок (вертикальні штрихи) 

7 Малюнок пастеллю 22 Імітація растрування 

8 Штриховий малюнок (нахилені штрихи) 23 Штриховий малюнок (горизонтальні штрихи) 

9 Малюнок вугіллям 24 Малюнок тушшю 

10 Малюнок восковими олівцями 25 Імітація зображення з пластиліну 

11 Малюнок графічним пером 26 Імітація тиснення 

12 Імітація гіпсового зображення 27 Малюнок аерографом 

13 Імітація барельєфу 28 Фреска 

14 Імітація скляного зображення 29 Малюнок восковими олівцями 

15 Вітраж 30 Малюнок крейдою 

Таблиця 8 — Приклад виконання роботи 4 

Зафарбований ескіз Зображення-пазл 
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Контрольні запитання усного звіту: 

1. Створення візерунків за допомогою Brush Tool? 

2. Створити власну форму пензля, внести до бази? 

3. Перетворити створені контури у виділену область? 

4. Зафарбувати та обвести створений контур пензлем? 

5. Налаштування інструменту Brush? 

6. Як імітувати вологі краї пензля? 

7. Як здійснити накладання текстури на пензлик? 

8. Створити візерунок, внести у базу існуючих? 

9. Створення та ретушування ефекту пазлу? 

10. Створити подвійний пензлик? 

11. Створити растровий шар інструментом Pen Tool? 

12. Створити векторну маску інструментом Pen Tool? 

13. Створити контур довільної форми  інструментом Pen Tool? 

14. Як змінити прозорість шару/зображення? 

15. Як створити групу шарів? 

16. Як встановити режим накладання шарів відмінний від Normal? 

17. Провести редагування ефектів, що застосовані до шару? 

 

ПРАКТИЧНА   РОБОТА   5 

РОБОТА З ТЕКСТОВИМ МАТЕРІАЛОМ 

Мета роботи: набуття навичок роботи з текстом; застосування до 

тексту ефектів деформації, фільтрів, вирізання, маскування зображення 

текстом; набуття навичок створення простої анімації, на прикладі gif-

зображень. 

Завдання роботи: створити відображення тіні, розмістити текст на 

об’ємному предметі та по контуру, каліграму (силует з тексту), розмістити 

зображення в тексті; створити вітальну листівку: цифри оформити 

зображеннями та пензлями, застосувати елементи анімації.  
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Теоретичні відомості: 

Робота з текстом. Для роботи з текстом 

призначений інструмент Text Tool, панель 

налаштувань інструмента Text, палітра Character 

та Paragraph. 

Деформація тексту виконується за допомогою 

палітри Warp Text. Для вставки зображення в 

текст необхідно скопіювати його в буфер 

обміну (Ctrl+C), потім виділити текст і виконати команду Edit Paste Into. 

Для виділення тексту необхідно натиснути на текстовий шар, утримуючи 

при цьому клавішу Ctrl. Для створення ефектів тексту слід застосувати Add 

a layer style та режим накладання шарів Layer Blend Mode відмінний від 

Normal. 

Застосовуючи пензлі до тексту, можна отримати цікаві ефекти. Щоб 

застосувати пензль до тексту, текст необхідно перевести в контур: виділити 

текст, а потім на палітрі Path клікнути ПКМ Make Work Path, потім 

виділити контур — ПКМ Stroke Path Brush. 

Для розміщення тексту по контуру необхідно створити довільний 

контур інструментами Pen Tool/Freeform Pen або Custom Shape Tool, 

виділити його, потім обрати інструмент Horizontal Type Tool підвести до 

контуру і ввести текст після того як курсор змінить свою форму на «напис 

по кривій/всередині кривої».  

Для створення 3D-тексту застосовуються функції 3D-моделювання 

меню 3D Repousse (Карбування) Text Layer, при цього програма 

раструє текстовий шар.  
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Фільтри до тексту застосовується лише при попередньому раструван-

ні: меню Layer Rasterize Type. Переміщення, деформація/ поворот літер 

у слові виконується лише при переведенні тексту в криві (фігури) Layer  

Type Convert to Shape, потім необхідно виділяти кожну літеру окремо 

інструментом Path Selection Tool і застосовувати до них Free Transform 

Path. 

Анімація. Проста анімація створюється за допомогою палітри 

Window  Timeline. Анімація являє собою зміну послідовних зображень 

для імітації певного руху/дії. Тому для початку необхідно створити вихідні 

зображення, які будуть відображатися певний період часу (0,1–1 с),  

і розмістити кожне з зображень на окремому шарі. Потім виділити перший 

шар і на палітрі Timeline натиснути Create Frame Animation, після цього 

додати всі шари на палітру Timeline: при натисненій клавіші Shift виділити 

всі шари і в налаштуваннях палітри Timeline обрати Make Frames From 

Layers. На палітрі Timeline обрати для кожного кадру час показу та режим 

відображення анімації (Once, 3times, Forever). Анімовані зображення 

зберігаються в форматі *.gif. Для цього необхідно зайти в меню File Save 

for Web і обрати відповідні налаштування: формат *.gif, кількість кольорів 

відображення, розмір тощо.  Перегляд анімації здійснюється через браузер, 

наприклад Enternet Explorer. 

Методика виконання роботи:  

1. Створити новий документ з властивостями: формат – А4, 

розташування – вертикальне, роздільна здатність – 150 dpi, колірний 

простір – RGB. 

2. Створити текст різними гарнітурами, різних кеглів, накреслення, 

пропорційності та застосувати до тексту: деформацію Warp, накладання 

градієнту/текстури, створення обведення, імітацію об’єму, тіні (табл. 11, п. 1).  
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3. Розмістити текст на об’ємному предметі (табл. 11, п. 2).  

4. Розмістити зображення в тексті (табл. 11, п. 3). 

5. Створити імітацію ефекту надпису на склі (табл. 11, п. 4). 

6. Застосувати до тексту фільтри та пензлі для обведення (табл. 11, п. 5). 

7. Створити 3D-текст та деформацію/поворот/зміщення тексту в слові 

(табл. 11, п. 6). 

8. Створити різні види тіней за зразком (табл. 11, п. 7–9) 

9. Розмістити текст по контуру об’єкта, згідно табл. 9 (табл. 11, п. 10–11). 

10. Створити каліграму (силует об’єкта з тексту), згідно табл. 9 (табл. 11, п. 12). 

11. Створити вітальну листівку, яка має один згин та містить чотири 

сторінки фарбовістю 4+4, відповідно до варіанту (табл. 10), обов’язково 

оформити цифри об’єктами/зображеннями, до літер застосувати пензлі та 

ефекти шару (табл. 11, п. 10).  

12. Зберегти файл (Прізвище_група_Lab5). 

13. У вітальну листівку додати ефекти анімації (зміна що найменше  

з п’яти зображень). 

14. Зберегти анімоване зображення у форматі *.gif. 

 

Таблиця 9 — Варіанти завдань для виконання практичної роботи 5, п. 10–11 

№  Об’єкт №  Об’єкт 

1 слон 6 ліхтар 

2 мавпа 7 пакунок 

3 трактор 8 валіза 

4 лев 9 парасоля 

5 метелик 10 крокодил 

11 автомобіль 24 зірка 

12 пальма 25 ялинка 

13 пелікан 26 відро 

14 ведмідь 27 квітка 

15 голуб 28 кит 

16 будинок 29 собака 

17 поїзд 30 людина 

18 келих 31 корова 

19 корабель 32 жираф 

20 кінь 33 літак 

21 павук 34 марсохід 

22 дельфін 35 пантера 

23 соняшник 36 фрукти 
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Таблиця 10 — Варіанти завдань для виконання практичної роботи 5, п. 12 

№ Дата Назва вітальної листівки 
Обрізний формат, 

мм 

1 1 січня  Новий рік  100×210 

2 7 січня  Різдво Христове  100×200 
3 8 березня  Міжнародний жіночий день  145×145 
4 за календарем Великдень  210×100 
5 за календарем День ангела  145×210 
6 9 травня  День Перемоги  145×210 

7 31 травня 
День працівників видавництв, поліграфії та книго-

розповсюдження України 
105×205 

8 31 січня  Всесвітній день ювеліра 115×170 
9 12 квітня День Авіації і Космонавтики  210×100 

10 22 січня  День Соборності та Свободи України  115×170 
11 25 січня  День студента (Тетянин день)  105×205 

12 21 лютого  День рідної мови  120×120 

13 14 жовтня  День захисника України  115×170 

14 27 березня  Міжнародний день театру  210×200 

15 1 квітня  День сміху; Міжнародний день птахів  100×210 

16 2 квітня  Міжнародний день дитячої книги  145×145 

17 7 квітня  Всесвітній день здоров’я  105×205 

18 22 квітня  Всесвітній день Землі  150×150 

19 29 квітня  Міжнародний день танцю  145×210 

20 3 травня  Всесвітній день свободи друку  100×210 

21 7 травня  Міжнародний день астрономії; День радіо  200×100 

22 11 травня  День Матері  115×170 

23 14 жовтня День українського козацтва 100×210 

24 1 червня  Міжнародний день захисту дітей  145×145 

25 8 липня  День рибалки  205×105 

26 12 липня  День фотографа  150×105 

27 23 серпня  День Державного Прапора України  100×210 

28 1 вересня  День знань  100×200 

29 9 вересня  День дизайнера-графіка  170×115 

30 13 вересня  День програміста; День українського кіно  200×100 

31 21 вересня  Міжнародний день миру  200×145 

32 5 жовтня  День працівників освіти; Міжнародний день вчителя  100×210 

33 23 жовтня  День працівників реклами (День рекламіста)  150×150 

34 10 листопада  Всесвітній день молоді  145×145 

35 14 лютого  День святого Валентина  100×200 

36 17 листопада  Міжнародний день студента  170×115 
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Таблиця 11 — Приклад виконання практичної роботи 5 

 

1 
 

2 

 

3 

 

4 
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Продовження табл. 11 

 
5 

 

6 

 

7 

 

8 

 

9 

 

10 

 

11 
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Закінчення табл. 11 

 

 

12 

 

13 

 

Контрольні запитання усного звіту: 

1. Як створити вертикальний/горизонтальний/під кутом текст? 

2. Як змінити характеристики тексту: колір, кегль, гарнітуру, шири-

ну, висоту символу, інтерліньяж? 

3. Як виконати зміщення літер у слові? 

4. Як виконати деформування тексту?  

5. Як вставити растрове зображення у текст? 

6. Як застосувати фільтри до тексту? 

7. Як створити контур по формі тексту та призначити обведення 

олівцем/пензлем? 

8. Як виконати зміщення літер у слові від базової лінії? 

9. Як створити ефект скляного тексту, силует фігури з тексту? 

10. Застосуйте до тексту градієнт/текстуру/тінь/ефект об’єму? 

11. Розміщення тексту на об’ємному предметі, по контуру фігури? 

12. Створення простої анімації? 

13. Зміна тривалості перегляду анімації? 
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ПРАКТИЧНА   РОБОТА   6 

РОЗФАРБОВУВАННЯ ЧОРНО-БІЛОГО ЗОБРАЖЕННЯ 

Мета роботи: навчитися змінювати колірний зміст зображень для 

закріплення навичок роботи з інструментами виділення, фарбування, 

фільтрами, корегувальними шарами, режимами накладання. Навчитися 

змінювати міміку обличчя, траєкторію розташування прикрас/предметів 

тощо. 

Завдання роботи: застосувати до чорно-білого зображення режими 

Duotone та Monotone, режим Bitmap за різними методами перетворення; 

розфарбувати чорно-біле зображення; здійснити корекції міміки обличчя. 

Теоретичні відомості: 

Розфарбовувати чорно-білі зображення можна декількома способами. 

Наприклад, для кожної частини зображення (шкіра, волосся, одяг) 

дублювати зображення Layer Dublicate Layer та застосовувати до них 

корегувальні шари Layer Create new fill or аdjustment Layer, підібравши 

необхідний. Потім на дубльованому шарі видалити зайві частини 

зображення і об’єднати корегувальний шар з нижнім шаром-дублікатом, 

для цього виділити шари з Shift, далі клік ПКМ Merge Layer.  

Інший спосіб для розфарбовування зображення: частини зображення 

замальовуються пензлем (кожну частину необхідно обмальовувати на 

новому шарі) і на палітрі Layer обрати необхідні налаштування Blend Mode 

(Режими змішування), Opacity/Fill (Прозорість/Заливання). Щоб при 

розфарбовуванні не втратити текстуру поверхні на палітрі Brushes 

необхідно включити пункт Texture і вибрати текстуру зі схожими 

показниками. Для тонування зображення або його частини також 

застосовується Image  Adjustment Photo Filter.  

Для виділення складних об’єктів, наприклад, волосся, хутро тварин, 

трави, використовується фільтр Filter Extract, а для створення карикатурних 
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ефектів та корекції міміки — Filter Liquify. Для проведення коригування 

форми, траєкторії розміщення об’єктів зручно користуватися інструментом 

Puppert Warp (меню Edit). Панель налаштувань Puppert Warp:  

 

Mode (Режим) — задає еластичність сітки: Rigit, Normal, Distort 

(строгий, нормальний, деформація). Density задає кількість опорних 

крапок, які блокують об’єкти до підкладу, в місцях їх розташування. 

Опорні крапки видаляються при натисненні клавіші Alt. Можна виконати 

обертання об’єкту навколо опорної крапки, для цього необхідно затиснути 

Alt і підвести курсор близько до опорної крапки до появи кола і дво-

сторонньої стрілки. Вказати кут повороту можливо в полі Rotate. Pin Depth 

(Глибина) дозволяє змінити порядок накладання, тобто обрати яка крапка 

буде ближче або далі.  

Для створення монохромних, дуплексних та інших колірних рішень  

у зображенні передбачені відповідні режими: Duotone, Monotone, Tritone, 

Quadtone, доступні при виконанні Image Mode Duotone. Для переведення 

зображення в зазначені режими, його попередньо треба перевести в чорно-

біле: Image Mode Grayscale. 

Зображення повинно бути в режимі RGB 

для переведення його в режим індексованих 

кольорів (застосовується у web-дизайні) 

Команда меню Image Mode Indexed Color 

відкриває діалогове вікно в якому задаються 

налаштування режиму: Palette — вибір 

готової палітри або способу розрахунку 

кольорів для створення палітри на основі 

зображення; поле Colors — задає кількість (от 2 до 256) кольорів в палітрі 

(чим меньше це число, тим меньше буде файл); список Forced дозволяє 

залишити незмінними деякі кольорі при індексації; список Matte дозволяє 
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обрати колір для напівпрозорих пікселів зображення (якщо поле 

Transparency активне; у випадку неактивного поля Transparency через 

список Matte заповнюються напівпрозорі та прозорі пікселі); список Dither 

дозволяє вибрати спосіб передачі градацій. Поле Preserve Exact Colors 

дозволяє включити в колірну палітру точні кольори вихідного зображення. 

Доступ до переведення зображення у режим Bitmap доступний лише 

після призначення Grayscale-режиму.  

Для коректного вибору та гармонійного поєднання кольорів часто 

застосовують програму Adobe Color CC (рис. 2), яка дозволяє створювати, 

редагувати, та зберігати колірні схеми відповідно до законів гармонії. 

 

Рис. 2 Інтерфейс програми Adobe Color CC 

Програма Adobe Color CC як самостійна палітра у програмі Photoshop,  

а також оn-line режимі через сайт www:color.adobe.com. Вибрані кольори 

можна визначити/призначити у програму Photoshop шляхом введення 

шістнадцяти значного коду (наприклад, FF0000) у діалогове вікно Color 

Picker. 

Методика виконання роботи: 

1. Відкрити цифровий файл, відповідно до варіанту.  

2. Створити необхідну кількість копій файлу. 
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3. За допомогою програми Adobe Color CC підібрати гармонійні 

кольори та розфарбувати зображення (табл. 12, кольорове зображення).  

4. До двох зображень застосувати режим Duotone та Monotone 

(табл. 12, дуплексне, монохромне зображення). 

5. До вхідного зображення застосувати режим Bitmap за різними 

методами перетворення (табл. 12). 

6. На основі створеного кольорового зображення провести корекції 

міміки обличчя, розташування предметів/кінцівок (табл. 12). 

7. Створити документи, відповідного розміру, для розміщення всіх 

створених зображень. 

8. Зберегти файл (Прізвище_група_Lab6). 

Таблиця 12 — Приклад виконання практичної роботи 6 

Корекція міміки обличчя: інструмент Puppert Warp, фільтр Liquify 
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Продовження табл. 12 

Чорно-біле зображення Кольорове зображення 

  

Дуплексне зображення Монохромне зображення 
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Закінчення табл. 12 

Bitmap: метод перетворення 

«Напівтоновий растр» 

Bitmap: метод перетворення 50 % 

Threshold 

  

Bitmap: метод перетворення 

«Регулярний шум» 

Bitmap: метод перетворення 

«Нерегулярний шум» 
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Контрольні запитання усного звіту: 

1. Як створити монохромне/дуплексне зображення? 

2. Як зберегти зображення, щоб збереглись шари та додаткові канали? 

3. Здійсніть масштабування/поворот/віддзеркалення/деформацію об’єкту 

у зображенні? 

4. Здійсніть масштабування/поворот/віддзеркалення зображення? 

5. Застосуйте до зображення коригувальні шари? 

6. Як створити новий файл? 

7. Як створити дублікат документу? 

8. Як змінити властивості створеного документу? 

9. Як встановити параметри кольорового охоплення? 

10. Як здійснити тонування зображення? 

11. Як створити ефекти постеру/акварелі/рисунку олівцем? 

12. Як відновити окремі частини зображення до початкового стану? 

13. Які налаштування містить палітра Layers? 

 

ПРАКТИЧНА   РОБОТА   7 

СТВОРЕННЯ ОРИГІНАЛ-МАКЕТУ ВИДАННЯ 

Мета роботи: закріплення навичок роботи з інструментами програми, 

такими як виділення, обрізання, ретушування, зафарбовування, текстові; 

командами та фільтрами обробки зображення. 

Завдання роботи: створити оригінал-макет відповідно до варіанту. 

Теоретичні відомості: 

Маска — це аналог виділенню, вона дозволяє закрити ділянки, які не 

потребують редагування. 

В якості маски, по-перше, можна зберегти виділення (Save Selection),  

і при необхідності його завантажити (Load Selection); по-друге, існує 

інструмент Edit in Quick Mask Mode, який дозволяє швидко виділити 

об’єкт за допомогою Brush Tool; по-третє, можна створити маску шару 

Layer mask. 
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Маска представляє собою чорно-біле зобра-

ження, чорні ділянки ховають елементи зобра-

ження, до якого маска застосована, а білі 

залишають видимими. До маски можна 

застосувати градієнт, що створить плавний 

перехід від одного зображення до іншого. 

Маску можна відключити (Disable), видалити 

(Delete), застосувати (Apply), додати її до виділенних ділянок (Add Layer 

Mask to Selection), видалити з виділенних ділянок (Substract Layer Mask 

from Selection), залишити лише перетинання виділення та маски (Intersect 

Layer Mask with Selection).  

Крім тріадних кольорів у макетах часто 

застосовують пантонні кольори, які в програмі 

розміщують в окремому каналі. Додаткові 

кольори, можна знайти в бібліотеці кольорів 

діалогового вікна Color Picker→Color Libraries/ 

Pantone Coated (Uncoated)/тощо. Також вибрати 

пантони можна відкривши Windows→Swatches. 

Пантонний колір, це лише пікселі з певними 

цифровими значеннями, і тому «відчуття» 

кольору є лише приблизним. Як правило, пантони не обирають «з монітору», 

для цього є спеціальні каталоги кольорів — пантонні віяла (колоргайди).  

Один із способів, яким можна виділити ділянку зображення, зберегти 

та призначити пантонний колір є Альфа-канали. Для цього необхідно 

виділити ділянку, якій буде присвоєно пантонний колір, і зберегти 

виділення Select→Save Selection. Перейти на палітру Channels обрати 

Channel Options в Color Indicates→Spot Color та обрати колір пантону. 

Потім необхідно при виділеному пантонному каналі на палітрі Channels 

інвертувати канал: Image→Adjustments→ Invert. Інший спосіб, виділити 

ділянку, якій буде присвоєно пантонний колір, перейти на палітру Channels 
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і в опціях обрати New Spot Channel, обрати 

колір пантону та його непрозорість Solidity. 

Ділянку зображення під пантоном, в тріадних 

каналах, необхідно видаляти або заливати 

білим кольором. 

Обробку зображень, як правило, виконують  

у найбільш зручному колірному просторі, який 

обирають відповідно до зображень індивідуально. Кольороподіл 

виконується лише один раз, що призводить до зміни RGB/CMYK-значень, 

таким чином, щоб кольори не спотворювалися, або якщо це є недосяжним, 

то зміна кольору була б мінімальною. Налаштування здійснюється через 

Edit→Color Settings. Конвертація зображення у простір, відмінний від 

робочого, здійснюється через Image→Mode або через призначення 

профілю виведення Edit→Convert to Profile. Пантонні канали можна 

об’єднати з каналами RGB/CMYK, при цьому об’єднуються шари: 

Channels→Merge Spot Channel. 

Для підключення екранної кольоропроби необхідно попередньо 

встановити профіль під який необхідно виконати кольоропробу: View→ 

Proof Setup→Custom (обирається заздалегідь налаштований профіль),  

а потім включити екранну кольоропробу (без переведення у профіль) 

View→ Proof Colors. Для визначення «проблемних» кольорів у зображенні, 

тобто, таких що будуть конвертуватися зі значними спотвореннями 

необхідно підключити: View→Gamut Warning («проблемні» кольори 

підсвічуються іншим кольором, по замовчуванню сірим). 

Треппінг — незначне перекриття (накладання) суміжних кольорів 

вздовж спільних границь зображення, з метою уникнення просвітів на 

зображенні та зведення до мінімуму несуміщення друкарських фарб. 

Полягає у створенні вузької смужки змішаних кольорів на межі об’єктів 
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різних кольорів. Залежно від насиченості кольору фону та об’єкту, який 

накладається, розрізняють такі режими треппінгу: внутрішній треппінг 

(сhoke trapping) стягування світлого фону всередину темного об єкта щоб

створити невелике перекриття зовнішній треппінг (spread trapping) 

розширення межі світлого об єкта розміщеного на темному фоні щоб 

створити невелике перекриття треппінг відключений (knockout) 

відбувається вирізання всією площі верхнього об’єкту з нижнього; 

треппінг накладанням (overprint) повне накладання верхнього об’єкту на 

нижній без вирізання (обов’язково використовується для тексту/штрихів/ 

ліній/об’єктів, відтворюваних чорною фарбою. Для реалізації «оверпрінту» 

для верхнього об’єкту необхідно змінити режим накладання з Normal на 

Multiply). Середній діапазон товщини треппінгу: 0,1–1 pt. Автоматичний 

треппінг виконується з допомогою команди Image→Trap, де задається 

лише товщина треппінга (доступно лише в режимі CMYK та при зведених 

шарах). Ручний метод передбачає стискання/розширення меж виділення 

(Select→Modify→ Contract/Expand, заливання відповідними кольорами або 

білим кольором відповідних ділянок у каналах. 

Для імпортування зображень в макет QuarkXpress необхідно 

використовувати наступні формати збереження: tiff для вставки растрових 

зображень (без контуру обрізки); eps для вставки векторних та растрових 

зображень (з/без контуром обрізки). Якщо розмір файлу перевищує 2 Гб 

або більше 30 тис. пікселів формат збереження *.psb (psd-формат до 2 Гб). 

Tiff дозволяє зберігати файли розміром до 4 Гб. 

Методика виконання роботи: 

1. Відповідно до варіанту (таблиця 13) визначити формат видання до 

та після обрізки. 
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2. Створити новий документ з властивостями: розміри видання до 

обрізки та розташування – відповідно до варіанту (таблиця 13), роздільна 

здатність – 300 dpi, колірний простір – RGB. 

3. Створити оригінал-макет (відповідно до варіанту, таблиця 13).  

4. Оригінал-макет повинен містити наступні обов’язкові елементи: 

– текст (наприклад, слоган, контакти); 

– ефекти шару; 

– прозорість; 

– градієнти; 

– пензлі; 

– перетікання об’єктів за допомогою масок. 

5. Обов’язково створити додатковий пантонний колір. 

6. Запропонувати спосіб друку майбутньої продукції та підібрати 

відповідний тип та налаштування кольороподілу зображення. 

7. Зберегти файл (Прізвище_група_Lab7.psd). 

 

Таблиця 13 — Варіанти завдань для виконання практичної роботи 7 

№ Назва оригінал-макету 

Формат 

аркуша  

(см) і доля  

1 Запрошення на промисловий ярмарок 84 100/32 

2 Афіша цирку 60 84/4 

3 Запрошення на концерт 60 90/32 

4 Рекламна листівка харчових продуктів 60 84/16 

5 Каталог побутових товарів 75 90/32 

6 Запрошення на виставку котів 60 90/32 

7 Афіша дельфінарію 62 84/4 

8 Каталог ювелірних прикрас 40 60/4 

9 Рекламна листівка напоїв 60 84/16 

10 Афіша зоопарку 60 84/4 

11 Рекламна листівка автосалону 60 63/6 

12 Каталог дитячих меблів 60 90/16 
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Закінчення таблиці 13 

№ Назва оригінал-макету 

Формат 

аркуша  

(см) і доля  

13 Листівка-запрошення на виставку квітів 90 60/40 

14 Каталог кімнатних рослин (палітурка) 70 100/16 

15 Рекламна листівка океанаріуму 60 84/16 

16 Запрошення на новорічну виставу 60 84/8 

17 Афіша кінотеатру 60 84/4 

18 Листівка-запрошення на виставку-ярмарок «Сад-город» 60 90/32 

19 Рекламний буклет канцтоварів 70 90/16 

20 Рекламний плакат магазину одягу 60 84/8 

21 Листівка-запрошення на виставку собак 60 84/32 

22 Рекламний плакат парфумерної продукції 84 108/32 

23 Каталог меблів 84 108/32 

24 Настінний календар 84 108/8 

25 Листівка-запрошення на виставку птахів 60 90/64 

26 Інформаційний проспект будівельної компанії 90 60/16 

27 Афіша театру 70 108/8 

28 Посібник з цифрової фотографії (обкладинка) 60 84/8 

29 Рекламна листівка ресторану 70 108/64 

30 Рекламна листівка туристичного агентства 90 70/16 

31 Політичний журнал (обкладинка) 70×100/16 

32 «Готуємо вдома» (палітурка) 60×84/16 

33 «Дім своїми руками» (обкладинка) 84×108/16 

34 Науково-популярний журнал «Навколо світу» 60×84/16 

35 Запрошення на виставку літаків та повітряних куль 84×108/64 

36 Афіша виставки динозаврів 84×108/6 
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Таблиця 14 — Приклад виконання практичної роботи 7 

Обкладинка журналу (перший варіант) 

 

Обкладинка журналу (другий варіант) 
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Таблиця 15 — Приклад виконання практичної роботи 7 

Канали Cmyk+Pantone Reflex Blue C 

Cmyk+Pantone Reflex Blue C Cyan 

  

Magenta Yellow 

  

Black Pantone Reflex Blue C 
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Контрольні запитання усного звіту: 

1. Які команди призначені для корегування яскравості/контрасту? 

2. Які команди призначені для корегування насиченості/колірного 

тону? 

3. Як створити негативне зображення?  

4. Як створити пантонний канал? 

5. Як змінити розмір зображення/робочого аркуша? 

6. Як змінити роздільну здатність/кольоровий простір зображення? 

7. Створити шар-маску/канал-маску? 

8. Як зберегти зображення, щоб збереглись шари та додаткові 

канали? 

9. Здійсніть налаштування кольороподілу? 

10. Створити профіль та виконати цифрову кольоропробу, 

застосувавши його? 

11. Налаштувати та виконати  кольороподіл? 

12. Застосуйте до масштабування зображення бікубічну інтерполяцію? 

13. Створити та відредагувати градієнт?  

14. Як виконується зсув об’єкту? 

15. Як визначити розмір об’єкта? 

16. Як змінити порядок накладання об’єктів? 

17. Як вирівнюються об’єкти між собою? 

18. Як вирівняти об’єкт по центру сторінки?  

19. Як створити колір з заданими показниками? 

20. Як зафарбувати об’єкт? 

21. Види інструментів зафарбування об’єктів? 

22. Як змінити розмір інструментів зафарбування? 

23. Як визначити показники кольору? 

24. Види інструментів видалення зображення? 
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ПРАКТИЧНА   РОБОТА   8 

РАСТРУВАННЯ ОРИГІНАЛ-МАКЕТУ ВИДАННЯ 

Мета роботи: закріплення навичок роботи із налаштування 

кольороподілу; навчитися обирати параметри растрування. 

Завдання роботи: перетворити тоновий оригінал-макет у растрован-

ний для візуальної імітації відбитку на матеріальному носії. 

Теоретичні відомості: 

Відповідно до технології виготовлення продукції обирається тип 

кольороподілу та параметри растрування, до яких відносять роздільну 

здатність виводу та лініатуру растрування, кути повороту для кожного 

каналу (кольору), форму растрової крапки.  

Для імітації растрування на відбитку можна скористатися 

функціоналом програми Adobe Photoshop за таким алгоритмом: 

1. Підготувати оригінал-макет та виконати кольороподіл, відповідно 

до вимог конкретного технологічного процесу виготовлення. 

2. Встановити мітки приведення, за допомогою інструменту Custom 

Shape Tool і в полі Shape обрати фігуру Registration Target (хрест 

суміщення). 

3. Об’єднати шари: палітра Layers→Flatten Image. 

4. Розділити канали: палітра Channels→Split Channels. 

5. Кожен окремий канал необхідно перевести в бітовий режим  

і раструвати: Image→Mode→Bitmap — при цьому обирається роздільна 

здатність виводу pixels/inch та тип растрування 

Halftone Screen; в меню Halftone Screen, обирається 

лініатура, кут нахилу та форма растрової структури. 

6. Всі відрастровані канали перевести в режим 

Grayscale: Image→Mode→ Grayscale→Size Ratio 1. 
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7. Переведені канали в Grayscale необхідно 

розфарбувати у відповідні кольори CMYK та 

Pantone. Для цього спочатку необхідно виділити 

інформацію через меню Select→Color Range→ 

Fuzziness 200. При цьому виділяються білі ділянки тому необхідно 

інвертувати виділення Select→Inverse і скопіювати виділення на новий 

шар палітра Layers→Duplicate Layer (Ctrl+J). Після цього конвертувати 

зображення у модель CMYK: Image→Mode→CMYK. Потім для кожного 

каналу обрати Blending Options→Color Overlay→Color Libraries→Pantone 

Process (Cyan, Magenta, Yellow, Black). 

8. Шар з ефектом накладання кольору перевести у смарт-об’єкт: 

Layers→Convert to Smart Object, а потім раструвати Layers→Rasterize 

Layer. 

9. Виконати суміщення всіх каналів (фарб) у порядку їх накладання, 

для цього почергово перетягувати пофарбовані канали у один збірний 

файл та сумістити по міткам приведення. 

10. Так як реальні фарби є напівпрозорими, необхідно змінити режим 

накладання для шарів на палітрі Layers з режиму Normal на 

Layers→Multiply. 

 

Таблиця 16 — Залежність лініатури/роздільної здатності виводу від типу матеріалу 

Тип матеріалу Лініатура, lpi 
Оптимальна роздільна 

здатність, dpi 

Газетний папір низької якості 80 до 1200 

Газетний папір 100 1600–2400 

Газетний/офсетний папір 133 2200–2540 

Якісний офсетний папір/ 

крейдований папір 
150 2540–2800 

Крейдований папір 175 2800–3200 

Крейдований папір високої якості 200 3200–3600 та вище 
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Стандартні кути повороту растрових сепарацій для 

офсетного друку Cyan 105 (15)°, Magenta 75°, Yellow 0 

(90)° (не дає муару), Black 45°
 
(растр найменш помітний).   

Відповідно до ISO 12647-2, при використанні двоосних 

періодичних растрів круглої або квадратної форми 

растрової крапки, різниця між кутами повороту растра 

для блакитної, пурпурної та чорної фарбами повинна 

становити 30°, а кут нахилу жовтої фарби — відрізнятися 

на 15° від двох інших. Кут повороту растра фарби, яка є 

домінуючою в зображенні, повинен бути рівний 45°. 

У разі використання растрів, які мають головну вісь 

(овальна або ромбічна точка), між кутами повороту 

головних осей блакитної, пурпурної та чорної фарб 

повинно бути 60°, а кут повороту жовтої фарби повинен 

відрізнятися на 15°. Кут нахилу домінуючої фарби 45° 

або 135°. 

Методика виконання роботи: 

1. На основі оригінал-макету, який створено у 7 роботі і відповідно 

до варіанту (таблиця 17) підібрати налаштування кольороподілу: Ink 

Options, Separation Options.  

2. Для растрування оригінал-макету необхідно обрати, відповідно до 

варіанту (таблиця 17): роздільну здатність виводу, лініатуру растрування, 

форму растрової крапки та кут повороту для кожного каналу (фарби). 

3. Обрані налаштування профілю виводу та растрування оформити 

письмово, надати пояснення щодо їх вибору (звіт з роботи підшивається 

до загального звіту з практичних робіт).  

  

Чорна фарба домінуюча 

Пурпурна фарба домінуюча 

Кут нахилу домінуючої фарби 

45 ° або 135 ° 
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Таблиця 17 — Варіанти завдань для виконання практичної роботи 8 

№ Назва оригінал-макету Технологія виготовлення видання 

1 Запрошення на промисловий ярмарок 
Аркушевий офсетний спосіб друку, папір 

крейдований матовий 

2 Афіша цирку Цифровий друк, папір крейдований матовий 

3 Запрошення на концерт Цифровий друк, папір крейдований 

4 Рекламна листівка харчових продуктів 
Аркушевий офсетний спосіб друку, папір 

офсетний 

5 Каталог побутових товарів 
Аркушевий офсетний спосіб друку, папір 

крейдований 

6 Запрошення на виставку котів 
Цифровий спосіб друку, папір крейдований 

матовий 

7 Афіша дельфінарію 
Аркушевий офсетний спосіб друку, папір 

крейдований 

8 Каталог ювелірних прикрас Цифровий друк, папір крейдований 

9 Рекламна листівка напоїв Рулонний офсетний спосіб друку, папір офсетний 

10 Афіша зоопарку 
Аркушевий офсетний спосіб друку, папір 

крейдований 

11 Рекламна листівка автосалону Цифровий друк, папір крейдований 

12 Каталог дитячих меблів 
Аркушевий офсетний спосіб друку, папір 

крейдований 

13 Листівка-запрошення на виставку квітів 
Цифровий спосіб друку, папір крейдований 

матовий 

14 Каталог кімнатних рослин (палітурка) 
Аркушевий офсетний спосіб друку, папір 

офсетний 

15 Рекламна листівка океанаріуму 
Аркушевий офсетний спосіб друку, папір 

крейдований 

16 Запрошення на новорічну виставу Цифровий спосіб друку, папір крейдований 

17 Афіша кінотеатру 
Аркушевий офсетний спосіб друку, папір 

крейдований 

18 
Листівка-запрошення на виставку-

ярмарок «Сад-город» 
Цифровий друк, папір крейдований 

19 Рекламний буклет канцтоварів 
Аркушевий офсетний спосіб друку, папір 

офсетний 

20 Рекламний плакат магазину одягу Цифровий друк, папір крейдований 

21 Листівка-запрошення на виставку собак 
Цифровий спосіб друку, папір крейдований 

матовий 

22 Рекламний плакат парфумерної продукції 
Аркушевий офсетний спосіб друку, папір 

крейдований 

23 Каталог меблів Цифровий друк, папір крейдований 

24 Настінний календар 
Аркушевий офсетний спосіб друку, папір 

крейдований 

25 Листівка-запрошення на виставку птахів 
Аркушевий офсетний спосіб друку, папір 

крейдований 

26 
Інформаційний проспект будівельної 

компанії 
Цифровий друк, папір крейдований 

27 Афіша театру Цифровий струминний друк, папір крейдований 

28 
Посібник з цифрової фотографії 

(обкладинка) 
Аркушевий офсетний спосіб друку, папір 

крейдований 
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Закінчення табл. 17 

29 Рекламна листівка ресторану Цифровий друк, папір крейдований матовий 

30 
Рекламна листівка туристичного 

агентства 
Аркушевий офсетний спосіб друку, папір 

офсетний 

31 Політичний журнал (обкладинка) Цифровий друк, папір крейдований 

32 «Готуємо вдома» (палітурка) 
Аркушевий офсетний спосіб друку, папір 

офсетний 

33 «Дім своїми руками» (обкладинка) 
Аркушевий офсетний спосіб друку, папір 

крейдований 

34 
Науково-популярний журнал «Навколо 

світу» 
Аркушевий офсетний спосіб друку, папір 

офсетний 

35 
Запрошення на виставку літаків та 

повітряних куль 
Аркушевий офсетний спосіб друку, папір 

офсетний 

36 Афіша виставки динозаврів Цифровий друк, папір крейдований 

 

 

Контрольні запитання усного звіту: 

1. Як налаштовується профіль виводу? 

2. Від яких показників залежить вибір налаштувань Ink Options, 

Separation Options? 

3. Від яких показників залежить вибір налаштувань растрування, 

 а саме вибір лініатури та роздільної здатності виводу; форми растрової 

крапки? 

4. Як обираються кути повороту растрових сепарацій (фарб)? 

5. Що забезпечує імітацію змішування фарб при накладанні одна на 

одну? 

6. Призначення растрування? 

7. Як виконати кольороподіл? 

8. Як перевести напівтонове зображення у бітове? 

9. Як інвертувати виділення? 

10. Як виконати екранну кольоропробу? 

11. Як розділити канали зображення? 

12. Як встановити мітки приведення фарб? 

13. Як здійснити конвертування зображення у смарт-об’єкт? 

14. Як виконати растрування векторного/смарт-шару? 
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Таблиця 18 — Приклад виконання практичної роботи 8 

Напівтонове зображення 

 

Растроване зображення 
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ПРАКТИЧНА   РОБОТА   9 

СТВОРЕННЯ ІНДИВІДУАЛЬНОГО ШАБЛОНУ ФОТОРАМКИ 

З ЕЛЕМЕНТАМИ АНІМАЦІЇ 

Мета роботи: закріплення навичок роботи з інструментами програми, 

такими як виділення, обрізання, ретушування, зафарбовування, текстові; 

командами та фільтрами обробки зображення; створення простої анімації; 

ознайомитися з роботою фільтра Adobe Camera Raw. 

Завдання роботи: створити оригінал-макет відповідно до варіанту. 

Теоретичні відомості: З метою створення індивідуального оформ-

лення та цікавого незвичного сприйняття фотографій досить часто 

застосовуються шаблонні цифрові фоторамки. Як правило, шаблони 

фоторамок поділяються по категоріям: дитячі, жіночі, чоловічі, молодіжні, 

сімейні тощо. У загальному випадку фоторамки являють собою колаж 

зображень на певну тематику з відведеним та окресленим місцем під 

фотографію.  

Для зручної та ефективної обробки цифрових фотографій призначе-

ний фільтр Adobe Camera Raw (ACR). При обробці зображень, як правило 

діють за принципом «спочатку налаштування градаційного діапазону, 

потім колір». Це означає, що спочатку потрібно привести до повного 

тоновий діапазон зображення. Порядок первинної корекції тонового 

діапазону: 

1. Спочатку налаштовується загальна яскравість зображення, яка 

виконується за допомогою регулятора Експонування/Exposure. 

2. Наступна операція — установка точки білого. Для цього використо-

вується параметр Білі/Whites. При налаштуванні точки білого потрібно 

обов’язково контролювати відкидання інформації в світлих ділянках 

(«переосвітлення»). 

3. Далі, за допомогою регулятора Світлини/Highlights можна налашту-

вати додаткове освітлення або затемнення (контраст) в ділянках світлих 
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тонів. Даний регулятор дозволяє підвищити або знизити деталізацію в 

світлих тонах (не плутати з різкістю). При цьому також потрібно 

контролювати відкидання інформації і, при необхідності, вносити 

корективи за допомогою регулятора Білі/Whites. Можливо, доведеться 

коригувати і загальну яскравість зображення. 

4. Наступний етап обробки — налаштування точки чорного, що 

виконується за допомогою регулятора Затемнення/Blacks. При установці 

точки чорного також важливо контролювати відкидання інформації у 

глибоких тінях. 

5. При необхідності проводимо освітлення або затемнення діапазону 

тіней, щоб проявити недостатньо видимі або приховати небажані деталі. 

Для цього використовуємо параметр Тіні/Shadows. Якщо при цьому 

відбулося зміщення точки чорного, підстроюємо повзунок Затемнення/ 

Blacks. Під час налаштування точок білого і чорного, а також діапазону 

світлин та тіней може змінитися загальна яскравість зображення, тому 

необхідно іноді повертатися і виконувати її налаштування за допомогою 

регулятора Експонування/Exposure. 

6. Налаштовуємо контраст зображення за допомогою регулятора 

Контрастність/Contrast. Надмірне підвищення контрасту «з’їдає» тонкі 

градації  

у світлиних і тінях, одночасно посилюючи насиченість зображення. 

7. Налаштування балансу білого, тобто якщо кольори зображення 

мають деякий сторонній відтінок, це легко виправити. Є три способи 

налаштування балансу білого в модулі ACR: 

7.1. Перший спосіб: вибір списку налаштувань. 

Для грубого початкового налаштування балансу 

білого можна скористатися налаштуваннями із 

списку параметра Баланс Білого/ White Balance. 

Тут доступні дев’ять різних значень. 
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7.2. Другий спосіб: використання інструменту Баланс Білого.  

Цей інструмент знаходиться 

на верхній панелі ACR і має 

вигляд піпетки. Щоб змінити баланс білого досить вибрати цей інструмент 

і клікнути на області, яка повинна бути нейтральною.  

7.3. Третій спосіб: ручне налаштування 

балансу білого. Температура/Temperature — 

цей слайдер змінює колірну температуру 

зображення. Якщо переміщати його вліво — 

зображення набуває синього відтінку, якщо 

вправо — жовтого. Відтінок/Tint — за 

допомогою цього слайдера прибирається пурпурний або зелений відтінок. 

Спочатку зазвичай налаштовують колірну температуру, а потім 

прибирають колірний відтінок, якщо він є. Також можна вводити числові 

значення з клавіатури. 

8. Якщо за задумом необхідно підняти 

деталізацію зображення в області середніх просто-

рових частот, що при помірному використанні 

надає додаткову глибину і об’єм, підкреслює різні 

фактури, слід скористатися регулятором Чіткість/ 

Clarity. При цьому, можливо, доведеться підправити 

параметри тонової корекції. 

9. За допомогою регуляторів Насиченість/Satu-

ration і Фарбовість/Vibrance можна надати сокови-

тість кольорам зображення, але надмірне підви-

щення насиченості шкодить деталізації і напів-

тоновим переходах.  
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Методика виконання роботи: 

1. Відповідно до варіанту (таблиця 19) створити документ з 

властивостями: розміри видання до обрізки та розташування – довільні, 

роздільна здатність – 300 dpi, колірний простір – RGB. 

2. Створити оригінал-макет цифрової фоторамки з використанням 

власного фото (відповідно до варіанту, таблиця 19).  

3. Для обробки власного фото використати фільтр Camera RAW 

(Photoshop CC) (бажано) або виконати аналогічну обробку в Photoshop CS5. 

4. Оригінал-макет повинен містити наступні обов’язкові елементи: 

– текст; 

– ефекти шару, фільтри; 

– прозорість; 

– градієнти; 

– пензлі; 

– перетікання об’єктів за допомогою масок. 

5. Обов’язково створити багатошаровий оригінал-макет. 

6. На основі готового шаблону фоторамки створити анімацію 

(мінімальна кількість кадрів п’ять). 

6. Зберегти файли (Прізвище_група_Lab9.psd, Прізвище_група_ 

Lab9.gif). 

 

Таблиця 19 — Варіанти завдань для виконання практичної роботи 9 

№ Тип фоторамки № Тип фоторамки 

1 Молодіжна весняна 12 Жіноча весняна 

2 Молодіжна вітальна 13 Чоловіча вітальна 

3 Жіноча літня 14 Дитяча зимова 

4 Дитяча вітальна 15 Весільна 

5 Весільна 16 Молодіжна літня 

6 Молодіжна осіння 17 Сімейна літня 

7 Жіночі вітальна 18 Сімейна весняна 

8 Дитяча літня 19 Чоловіча вітальна 

9 Жіноча зимова 20 Молодіжна зимова 

10 Чоловіча зимова 21 Дитяча літня 

11 Весняна вітальна 22 Молодіжна вітальна 
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Таблиця 20 — Приклад виконання практичної роботи 9 
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Продовження табл. 20 
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Закінчення табл. 20 

  
 

 

Контрольні запитання усного звіту: 

1. Як здійснюється обробка зображень за допомогою фільтра Camera Raw?  

2. Як налаштувати баланс білого, якщо зображення має сторонній 

відтінок?  

3. Як підвищити деталізацію зображення? 

4. Як налаштувати загальну яскравість зображення? 

5. Як проводити освітлення/затемнення ділянок тіньового діапазону? 

6. Як контролювати відкидання інформації у високих світлинах? 

7. Як створюється проста анімація? 

8. Як додати проміжні кадри у анімацію? 

9. Як коректно зберегти анімацію для перегляду? 

10. Як управляти об’ємом gif-файлу?  
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ПРАКТИЧНА   РОБОТА   10 

СТВОРЕННЯ ФОТОКНИГИ ЗАСОБАМИ ПРОГРАМИ  

ADOBE LIGHTROOM 

Мета роботи: навчитися створювати каталоги фотографій; на основі 

шаблонів фотокниг програми Adobe Lightroom створити свою фотокнигу, 

використавши попередньо оброблені зображення.  

Завдання роботи: створити оригінал-макет фотокниги. 

Теоретичні відомості: Для створення фотоальбому необхідно 

підготувати та обробити зображення засобами програми Adobe Photoshop, 

плагіном Camera Raw або доопрацювати у Adobe Lightroom модуль 

Develop. Для імпорту зображень у Lightroom необхідно обрати File  

Import Photos and Video зображення з’являються на панелі Catalog модуля 

Library, а потім, для зручності, необхідно обрати саме ті фото, які будуть 

використані у фотокнизі. Для цього фото сортуються за допомогою Library 

Filter  Attribute за певними атрибутами, наприклад кольором, який 

попередньо призначається зображенням. Всі відсортовані зображення 

виділяються (Ctrl+A) і заносяться до нової колекції: collections Сreate 

Сollection (табл. 21).  

Таблиця 21 — Палітри модуля Library 
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Для створення оригінал-макету книги необхідно перейти до модуля 

Book, який містить наступні панелі: 

 

 

 

 

 

 

 

 

Панель Book Settings (Параметри книги): 

Містить формати виводу: Blurb, pdf, jpeg. 

Розмір фотокниги. 

Тип обкладинки: без (None), палітурка (Hardcover Image Wrap), палітурка  

з клапанами (Hardcover Dust Jacket), обкладинка (Softcover). 

Якість jpeg файлу, профіль та роздільна здатність. 

 

Різкість: Low (низька), Standart (стандартна), High (висока). 

Тип паперу: Glossy (глянцевий), Matte (матовий). 

Панель Page містить шаблони сторінок, які відкриваються при 

натисненні на трикутник справа, та кнопки додавання сторінок у макет. 

Шаблони для обкладинки/палітурки стають активними при натисканні на 

трикутник знизу активної сторінки обкладинки/палітурки. 

Панель Caption призначена для створення підписів Photo 

Caption/Page Caption (під зображенням/сторінкою). Поле 

Offset дозволяє зміщувати напис у потрібне місце; поля 

Above/Over/Below додає підписи над/на/під зображенням. 

Панель Type містить стандартні налаштування для текстової 

інформації: гарнітуру, накреслення, кегль, прозорість, трекінг, зміщення 

від базової лінії, інтерліньяж, кернінг, колонки, вирівнювання. 

Панель Background призначена для налаштування графіч-

ного оформлення фону сторінок фотокниги. При вста-

новленні Apply Background Globally призначається ідентичне 

оформлення фон для всіх сторінок. Поле Drop Photo Here 

дозволяє в якості фону використати зображення, при цьому 

також налаштовується його прозорість. Колір фону обирається у полі 

Background Color. 

Налаштування фотокниги для виводу 

Автомакетування 

Форматування сторінок 

Відображення напрямних 

Розміри комірок для фото 

Підписи під фото/сторінкою 

Налаштування тексту 

Налаштування фону 
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Створення оригінал-макету фотокниги починається з вибору формату 

на панелі Book Settings Size. Для того, щоб мати можливість індиві-

дуально оформити кожну сторінку необхідно очистити налаштування 

шаблону: Clear Book. Для перегляду фотокниги в цілому, розвороту, 

сторінки у вікні макетування є кнопки: Multi Page View, Spread View, 

Single Page View              . 

Після вибору необхідного шаблону, зображення розміщуються у книзі 

вручну, перетягуючи у потрібне місце.  

 

Для збереження макету фотокниги у Adobe Lightroom необхідно 

натиснути Create Saved Book, макет можна відкрити з панелі Сollections. 

Збереження для виводу здійснюється через Export Book to Jpeg,  

в результаті створюється папка з посторінковими файлами фотокниги. 

Модуль Auto Layout дозволяє 

виконати автоматичне макету-

вання фотокниги, при цьому 

обираються шаблони розташу-

вання зображень/тексту для 

правої та лівої сторінки: Auto 

Layout  Preset Edit Auto Layout 

Preset. Обрані налаштування 
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зберігаються у полі Preset Save Current Settings as New Preset. Для 

застосування створеного шаблону його необхідно обрати на панелі Auto 

Layout у полі Preset, а потім натиснути Auto Layout. 

Модуль Book пропонує шаблони на основі американських форматів,  

і відповідно не дозволяє задати довільні формати фотокниги. У випадку 

необхідності використання іншого формату можна використати модуль Print, 

який має схожі налаштування з модулем Book. 

Методика виконання роботи: 

1. Підготувати та обробити зображення засобами програми Adobe 

Photoshop/Camera RAW/Adobe Lightroom. 

2. Cтворити фотокнигу довільного формату, мінімальна кількість 

сторінок — 12. Формат виводу pdf, роздільна здатність – 300 ppi, колірний 

простір – sRGB.   

3. Оригінал-макет фотокниги повинен містити зображення та текст, 

тип обкладинки/палітурки студент обирає самостійно. 

4. Зберегти фотокнигу у Adobe Lightroom, та експортувати у pdf. 

(Прізвище_група_Lab10.pdf). 

 

Контрольні запитання усного звіту: 

1. Як створити макет фотокниги у програмі Adobe Lightroom? 

2. Як виконати автоматичне макетування лівої/правої сторінок? 

3. Як імпортувати зображення у програму Adobe Lightroom? 

4. Як здійснити сортування зображень за допомогою Library Filter? 

5. Як встановити підпис під зображенням/сторінкою? 

6. Як призначити однаковий/різний фон для сторінок фотокниги? 

7. Які формати доступні для збереження фотокниги? 

8. Як редагується текстова інформація у програмі Adobe Lightroom при 

створенні фотокниги? 
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ПИТАННЯ   ДЛЯ   САМОКОНТРОЛЮ 

1. Як створити новий файл? 

2. Як створити дублікат документу? 

3. Як змінити властивості створеного документу? 

4. Як встановити параметри колірного охоплення? 

5. Які дії необхідно виконати для збереження файлу? 

6. Які типи файлів допустимі для відкриття? 

7. Які типи файлів допустимі для збереження? 

8. Як підключити панель інструментів? 

9. Як підключити/закрити необхідні палітри? 

10. Як наблизити/віддалити об’єкти на екрані? 

11. Як побачити об’єкти на екрані у певному масштабі? 

12. Як показати/сховати лінійки? 

13. Як показати/сховати/заблокувати направляючі? 

14. Як встановити (змінити) нуль координат? 

15. Як виділити/видалити будь-який об’єкт? 

16. Види інструментів виділення? 

17. Як зберегти/завантажити виділення? 

18. Як змінити показники виділення? 

19. Як віддзеркалити будь-який об’єкт? 

20. Як виконати дублювання/транформування об’єкту? 

21. Як скопіювати, перемістити об’єкт в межах аркушу, повернути об’єкт 

на певний кут? 

22. Як виконується зсув об’єкту? 

23. Як визначити розмір об’єкта? 

24. Як змінити порядок накладання об’єктів? 

25. Як вирівнюються об’єкти між собою? 

26. Як вирівняти об’єкт по центру сторінки?  
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27. Як створити колір з заданими показниками? 

28. Як зафарбувати об’єкт? 

29. Види інструментів зафарбування об’єктів? 

30. Як змінити розмір інструментів зафарбування? 

31. Як визначити показники кольору? 

32. Види інструментів видалення зображення? 

33. Як створити додатковий контур об’єктів? 

34. Як перетворити векторний контур у виділення?  

35. Як створити лінійний, відцентрований; циліндричний, пірамідальний, 

конусоподібний градієнт? 

36. Як створити багатоколірний градієнт? 

37. Як змінити колір у створеному градієнті? 

38. Як застосувати градієнт до тексту? 

39. Як згрупувати/розгрупувати (об’єднати) об’єкти? 

40. Як заблокувати об’єкти? 

41. Яка створити новий шар? 

42. Яким чином можна включати/виключати шари? 

43. Чим характеризується кожен шар? 

44. Яким чином можна зробити шари невидимими? 

45. Як об’єднати/видалити/дублювати шари? 

46. Як змінити прозорість шару/зображення? 

47. Як створити групу шарів? 

48. Як встановити режим накладання шарів відмінний від Normal? 

49. Як створити вертикальний текст, текст під кутом? 

50. Як змінити характеристики тексту: колір, кегль, гарнітуру, 

інтерліньяж? 

51. Як виконати деформування тексту?  

52. Як вставити растрове зображення у текст? 

53. Як створити тінь від об’єкту? Як змінити колір тіні? 
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54. Як створити/змінити опуклість об’єкту? 

55. Як створити/редагувати/зафарбувати векторний контур? 

56. Як створити/застосувати візерунок? 

57. Як здійснити кадрування зображення? 

58. Як видалити шуми, подряпини? 

59. Як здійснити клонування частини зображення? 

60. Як позбутися муару? 

61. Як підвищити різкість зображення? 

62. Призначення команди Levels? 

63. Які команди призначені для корегування яскравості/контрасту? 

64. Які команди призначені для корегування насиченості/колірного тону? 

65. Як створити негативне зображення? 

66. Як змінити розмір зображення/робочого аркуша? 

67. Як змінити роздільну здатність/кольоровий простір зображення? 

68. Призначення/види масок? 

69. Як працює маска? 

70. Як застосувати/відключити/видалити маску? 

71. Види/призначення меню Filter? 

72. Як створити ефекти об’ємних об’єктів? 

73. Як створити відблиск на об’єкті? 

74. Як здійснити тонування зображення? 

75. Як створити ефекти постеру/акварелі/рисунку олівцем? 

76. Створення простої анімації? 

77. Зміна тривалості перегляду анімації? 

78. Здійснення корекції зображень за допомогою фільтру Adobe Camera Raw? 

79. Проведення корекції розташування предметів/кінцівок? 

80. Створення додаткового (пантового) кольору? 
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Додаток 1 

ПАЛІТРА  ОСНОВНИХ  ІНСТРУМЕНТІВ  (TOOLS) 

№ Назва інструменту Призначення 

 
Move  Для вибору шарів, переміщення об’єктів  

 

Rectangular Marquee, 
Elliptical Marquee, Single 
Row Marquee, Single Column 

Для виділення частини документу (має різновиди 
— прямокутник, овал, рядок, стовпчик) 

 

Lasso, Polygonal Lasso, 

Magnetic Lasso  
Для створення виділення складної форми 

 
Magic Wand, Quick Selection  

Для виділення частини документу одного 

кольору 

 
Crop  Кадрування документу 

 
Slice, Slice Select  Для розрізання зображення на частини 

 

Spot Healing Brush,  Healing 

Brush, Patch, Red eye Tool 

Для швидкого видалення незначних дефектів, 

подряпин/ сколів (має різновиди — заміна 

фрагменту, видалення ефекту «червоних» очей) 

 
Pencil, Brush  

Для малювання (має різновиди — олівець, 

пензлик) 

 
Clone Stamp, Pattern Stamp  Клонування частин зображення 

 

History Brush, Art  History 

Brush   
Відновлює зображення до початкового стану 

 

Eraser, Background Eraser, 

Magic Eraser  
Для стирання зображення 

 
Gradient, Paint Bucket  

Створення градієнтів (має різновид однорідного 

зафарбування, діє на виділеній ділянці) 

 
Blur, Sharpen, Smudge 

Для створення ефектів: розмиття/наведення 

різкості, витягування) 

 
Dodge, Burn, Sponge Для висвітлення або затемнення ділянки зображення 

 

Pen, Freeform, Add Anchor 

Point, Delete  Anchor Point, 

Convert  Anchor Point 

Для створення та редагування векторних 

контурів 

 
Horizontal Type 

Для створення/редагування тексту, як 
горизонтального так і вертикального 

 

Path Selection, Direct 

Selection 
Для переміщення векторних контурів 

 

Ellipse, Rectangle, Rounded  

Rectangle, Polygon, Line, 

Custom Shape 

Створення геометричних фігур 

 
Notes Створення позначень в документі 
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Продовження додатку 1 

 

№ Назва інструменту Призначення 

 

Eyedropper,Color Sampler, 

Measure 
Вимірювання кольору крапки 

 
Hand 

«Рука» для переміщення по документу та 

орієнтації документа 

 
Zoom Масштабування документу 

 

Default Foreground and 

Background Colors 

Встановлення початкових кольорів для фону та 

переднього плану. Switch Foreground and 

Background Colors змінює місцями між собою ці 

кольори 

 

Set Foreground Color/Set 
Background Color 

Обрані значення кольору в документі на даний 

час 

 
Edit in Quick Mask Mode Включення/виключення режиму швидкої маски 

 
Change Screen Mode Зміна налаштування робочого простору 
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